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Purchasing

SIMMS has many features to help you manage your procurement pro-
cess, such as the ability to create purchase orders, receipt of goods, set 
item reorder points, and authorize purchase orders.

In addition, these features are integrated, creating a seamless work-
flow. For example, you can import the details of a purchase order into a 
receipt of goods. This reduces the time needed for you to complete your 
receipt of goods.

Setting an items reorder point automates the replenishment process 
and reduces the chance of stock shortages. When an item falls below its 
set reorder point it is listed in the Reordering Purchase Order window. 
From this window, you can create the purchase orders needed to replen-
ish your stock.

You can implement a one or two tier purchase order authorization pro-
cess. Either option, when implemented, requires that your purchase 
orders are authorized before they are released to a vendor.

With a two tier authorization process you have the optional feature of 
using budget categories. Budget categories limit the amount of money 
that is spent for any given purpose (such as office or maintenance sup-
plies) and restricts who is allowed to spend from a specific budget cate-
gory. 

Creating a Purchase Order
Use SIMMS’ Purchase Order Manager and Purchase Order window to 
create your purchase orders.

Begin in the Purchase Order Manager by creating a blank purchase 
order. This blank purchase order opens in the Purchase Order window. 
There you enter your purchase order’s details, such as the vendor’s 
name and the items you are purchasing from them.

Keep in mind that many of the details for your purchase order are 
optional, such as the contact name, shipping method, manufacturer’s lot 
number and so on.

In addition, SIMMS can enter many of your purchase order’s details 
automatically, this depends on what default information you have pre-
viously entered into SIMMS. For example, if when setting up your ven-
dor’s profile in the Vendor Manager, you entered your vendor’s 
purchase terms, SIMMS enters this detail automatically when you cre-
ate your purchase order for that vendor.
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Create a Blank Purchase Order
1. Open the Purchasing menu, and then click Purchase Order 

Manager.

The Purchase Order Manager window opens.

2. Click the New icon .

Your blank purchase order opens in the Purchase Order win-
dow.

Enter the Header Details for a Purchase Order
In the blank purchase order you created, enter your purchase order’s 
details. Start by entering the appropriate details in the Header tab.

Figure 1: Entering the header details for a purchase order.

1. In the Vendor list, select a vendor.

2. In the Contact list, select your contact at this vendor.

3. In the Agent list, select the purchasing agent responsible for 
this purchase order.

4. In the Terms list, select the terms for this purchase order.

5. In the Required Date box, select the date you require the 
items on your purchase order.

By default, SIMMS enters a date 30 days from the current date. 
To change this setting go to Setup > Global Settings > Purchase 
tab > Default Required Date for Purchase Orders. 

6. In the Document No. text box, type a document number for 
your purchase order.

If you import this purchase order into a receipt of goods, the 
document number you enter here is also used as the document 
number for your receipt of goods.
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7. If you want to replace an item’s default location as you enter 
that item onto your purchase order, in the Default Location 
list, select your item’s replacement location.

Each time you enter an item on your purchase order, SIMMS 
replaces the item’s default location (as assigned in the Item 
Manager) with the location you select from this list.

Use this feature if you want to quickly assign the same location 
to multiple items as you enter them on to your purchase order.

8. If for this purchase order you are using a foreign currency, in 
the Foreign Currency list, select that currency.

9. In the Department list, select a department.

10. In the Mfr. Lot list, select a manufacture's lot.

Each time you enter an item on your purchase order, SIMMS 
enters the manufacturer’s lot you select from this list as your 
item’s manufacturer’s lot.

To add a manufacturer’s lot to the list, click the Ellipses but-
ton . The Manufacturer Lot Management dialog box opens. 
In the Manufacturer Lot field, type a manufacturer's lot. In 
the Description field, type a description.

11. In the Comments text box, type a comment.

This comment appears on your printed purchase order.

Enter the Shipping Details for a Purchase Order
1. Click the Shipping tab.

Figure 2: Entering the shipping information for a purchase order.

2. In the Shipping Method list, select a shipping method for the 
items on your purchase order.

You can select alternate bill-to and ship-to 
address for your purchase order.

Click the Customer Drop Ship check box to have the items 
on your purchase order directly shipped to your customer.
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3. In the Shipping Via text box, type any additional shipping 
details specific to your selected shipping method.

4. In the Ship Account Number text box, type the appropriate 
shipping account.

5. To change the bill-to address for this purchase order, in the 
Bill-To Address list, select the new address.

6. To change the ship-to address for this purchase order, in the 
Ship-To Address list, select the new address.

7. If the items on the purchase order are being delivered directly 
to your customer (drop shipped), click the Customer Drop 
Ship check box. And then, in the list of customers (below the 
Customer Drop Ship check box) select the customer you want 
the items on the purchase order delivered to.

SIMMS enters your customer’s address as the ship-to address 
for the purchase order.

Attach a Document to a Purchase Order
You can attach a document such as a Microsoft Word file, PDF, or image 
to your purchase order.

You can also view the documents you attach to a purchase order in the 
Vendor Manager’s entry for your vendor.

To attach a document to a purchase order do the following steps:

1. In the Purchase Order window, click the Attach tab, and 
then click New Document.

The Attach Documents window opens.

Figure 3: Attaching a document to a purchase order.

2. Click Browse.

Click Attach to move your 
selected file to the text box.

Click Upload to upload your docu-
ment to your company database.
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The Find File window opens.

3. In the Find File window, locate the document you want to 
attach to your purchase order, and then click Open.

The Find File window closes.

4. In the Attach Documents window, click Attach, and then 
click Upload.

SIMMS attaches your document to your purchase order.

Add an Item to a Purchase Order
You have entered the header and shipping details for your purchase 
order. (Optionally, you may have attached a document to your purchase 
order). Next you add to your purchase order the items you are purchas-
ing.

1. Click in the Item Code field, and then click the Search icon 
 that appears.

Figure 4: Adding an item to a purchase order.

The Enhanced Search window opens.

2. In the Description field, type the description for your item, 
and then click Find.

Your item is listed in the Enhanced Search window’s grid.

3. Select your item, and then click Retrieve One.

SIMMS enters your item’s details in the Purchase Order win-
dow’s grid.

Tip: There are many ways to enter an item’s details into a purchase 
order. For example, you can scan the item’s UPC code or select the item 
from the Stock Window.

In addition, you can type an item’s code or description in the appropriate 
fields of the purchase order’s grid and then press the Tab key. SIMMS 
automatically enters the remaining details for your item in its row.

If you click in the Item Code field, the Search icon appears. Click the Search 
icon to open the Enhanced Search window. In the Enhanced Search window 
you find and retrieve the item you want to add to your purchase order. 
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Even if you only type a portion of your item’s description or code and 
then press the Tab key, SIMMS is often able to determine the item you 
want. If SIMMS is unable to determine the exact item you want, the 
Enhanced Search window opens, listing the most likely candidates.

Edit an Item’s Details for a Purchase Order 
You can edit an item’s details such as its location or quantity. For a list 
and explanation of the item details you can edit, see Table 1: Edit an 
Item’s Details for a Purchase Order.

Table 1: Edit an Item’s Details for a Purchase Order

Fields Explanation

UM In this field SIMMS enters your 
item’s purchase unit of measure. If 
you have not defined a specific pur-
chase unit of measure for your item, 
SIMMS enters your item’s standard 
unit of measure as its purchase unit 
of measure.

In the field’s list, you can choose any 
of the available units of measure you 
have previously defined for your 
item.

Location In this field SIMMS enters the 
default location of your item. It is 
into this location that your item is 
received and stored. 

You can change this location by 
selecting a new location from the 
fields list.

Manufacturer Lot In this field you type a manufac-
turer’s lot for your item.

Exp. Date In this field you select your item’s 
expiration date from the field’s cal-
endar.
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Alias In this field’s list, you select the alias 
(name) your vendor uses for this 
item.

Comment In this field you type a comment to 
associate with your item.

If your item has an extended descrip-
tion, SIMMS automatically enters it 
in this field. You can edit the 
extended description or replace it 
with a comment.

The item’s extended description/com-
ment appears on your printed pur-
chase order. 

Quantity In this field you type the quantity of 
the item you are ordering.

By default SIMMS enters one (1) as 
your item’s order quantity.

Service In this field’s list, you select the ser-
vice order you want to associate with 
your purchase order.

To appear in this list, the service 
order must be created first.

Markup% In this field you add a markup per-
centage for your item.

After changing the markup percent-
age for your item, its cost (in the 
Cost field) changes to reflect the 
adjustment to the markup percent. 

Table 1: Edit an Item’s Details for a Purchase Order

Fields Explanation
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Enter a Freight Charge or Extra Discount in the Totals Pane
The Totals pane appears at the bottom of the purchase order window. It 
contains information such as taxes charged and the grand total. In this 
pane you can add a freight charge and an extra discount to your pur-
chase order.

Figure 5: Entering freight costs and extra discount in the Totals pane.

1. In the Totals pane, in the Freight text box, type the freight 
charge you want to add to your purchase order.

2. In the Extra Discount % box, type the percentage of your 
extra discount.

The extra discount is taken off your purchase order’s net total.

3. Click the Save icon .

Replace an Item with its Compatible Item
A compatible item is one item that you can substitute for another item. 
You assign an item’s compatible in the Item Manager.

Cost In this field SIMMS enters the cost 
for your item.

You can change your item’s cost. 
After changing your item’s cost, its 
markup percentage (in the Markup% 
field) changes to reflect the adjust-
ment to the item’s cost.

Table 1: Edit an Item’s Details for a Purchase Order

Fields Explanation

You can enter freight costs 
to your purchase order.

You can enter an extra discount to 
your purchase order.
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To assign an item’s compatible go to Item Manager > Tools > Com-
patible Items.

To replace an item with its compatible do the following steps: 

1. In the Purchase Order window’s grid, select the item you 
want to replace with its compatible.

2. On the Item menu, click Compatible Items.

The Stock Window opens.

SIMMS lists in the Stock Window, your item’s pre-defined
compatible.

3. In the Stock Window, select the compatible you are substitut-
ing for your item, and then click Select.

The Stock Window closes.

In the Purchase Order window’s grid, SIMMS replaces your 
original item with its compatible. 

Clone a Purchase Order
You can make an exact copy of an existing purchase order. This is a 
quick way to create a purchase order that has the same or similar 
details as an existing purchase order.

1. Open the Purchase Order Manager, click the Clone Pur-

chase Order icon .

The Clone Purchase Order window opens.

2. In the window’s grid, select the purchase order you want to 
clone, and then click OK.

3. SIMMS displays a message confirming your new purchase 
order is saved. Click OK.

You can view your purchase order from the Purchase Order 
Manager.

Working With Purchase Orders
The Purchase Order Manager is designed as the entry point from which 
you perform many of the tasks related to working with your purchase 
orders. For example, from the Purchase Order Manager you can print a 
SIMMS 8.0 · Purchasing May 18, 2011 9



purchase order, place a purchase order on hold, or view an existing pur-
chase order.

Figure 6: The Purchase Order Manager.

View an Existing Purchase Order

 Open the Purchase Order Manager, select the purchase 

order you want to view, and then click the View icon .

Your purchase order opens in the Purchase Order window.

Place a Purchase Order on Hold
Place a purchase order on hold if you want to temporarily prevent the 
purchase order from being imported into a receipt of goods.

1. Open the Purchase Order Manager. On the Tools menu, 
click Purchase Order on Hold. 

The PO On Hold window opens.

2. In the OnHold column, click the check box for the purchase 
order you want to place on hold, and then click OK.

Note: To remove the hold on a purchase order, in the OnHold column 
clear the check box for the purchase order.

Manually Close a Purchase Order
You can manually close a purchase order before you receive any or some 
of the items on the purchase order. A purchase order that is closed can-
not be imported into a receipt of goods. Manually close a purchase order 

From the toolbars you have access to 
most of the features needed to work 
with your purchase orders.

SIMMS lists in the Purchase Order 
Manager your purchase orders. The 
list is filtered by date.
10 March 18, 2011 SIMMS 8.0 · Purchasing



if you want to stop items on the purchase order from being received into 
stock.

1. Open the Purchase Order Manager, select the purchase 
order you want to close, and then click the Close Purchase 

Order icon .

The Close Purchase Order window opens.

2. In the Closed column, click the check box for the purchase 
order you want to close, and then click Save.

View Purchase Orders Close to Expiring
You can view a list of purchase orders close to expiring. By default a 
purchase order expires 30 days after you save the purchase order.

To change the number of days before a purchase order expires, go to 
Setup > Global Settings > Purchase tab, in the Purchase orders 
expire after box, type the number of days before a purchase order 
expires. 

To view a list of purchase orders close to expiring, do the following 
steps: 

1. Open the Purchase Order Manager, click the Purchase 

Orders Close to Expiration icon .

The Documents Close to Expiration window opens.

Listed in the window are your purchase orders close to
expiring.

2. To view the details of a purchase order, select the purchase 
order, and then click Details.

Your purchase order opens in the Purchase Order window.

Print a Purchase Order
1. Open the Purchase Order Manager, select the purchase 

order you want to print, and then click the Print icon .

Your purchase order opens in the Report window.

2. Click the Print icon .

Edit a Purchase Order
1. Open the Purchase Order Manager, select the purchase 

order you want to edit, and then click the View icon .

Your selected purchase order opens in the Purchase Order
window.
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2. Click the Edit icon .

3. Edit your purchase order, and then click the Save icon . 

Delete a Purchase Order
1. Open the Purchase Order Manager, select the purchase 

order you want to delete.

2. On the File menu, click Delete.

3. SIMMS prompts you to confirm that you want to delete the pur-
chase order, click Yes.

4. SIMMS confirms the purchase order is deleted, click OK.

Create a New Sales Order Based on a Purchase Order
Before saving your purchase order, you can create a sales order based 
on your purchase order.

1. Create a purchase order. Before saving your purchase order, on 
the Tools menu, click New SO Based on Current PO.

The New Sales Orders dialog box opens.

Figure 7: Creating a sales order based on a purchase order.

2. Do one of the following steps:

• To add your items to an existing sales order, in the list 
adjacent to the Create one document option, select the 
sales order number.

• To create a new sales order, in the list of your customers 
(bottom) select a customer.

3. Click OK.

After you save your purchase order, SIMMS either adds the 
items on your purchase order to an existing sales order or cre-
ates a new one. This depends on your choices above.

To add your items to an existing 
sales order select the sales order 
number from this list. To create a 
new sales order, leave the list at 
its default value, New.

If you are creating a new sales 
order for your items, select your 
customer from this list.
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Item Reorder Points
Use item reorder points to maintain economic stock levels and at the 
same time prevent stock shortages. An item’s reorder point is the item’s 
stock level that triggers the replenishment process. As soon as an item’s 
available quantity is equal to or less than its reorder point, the item 
requires reordering.

You can have SIMMS alert you when items require reordering. You 
enable reordering alerts in SIMMS Server Agent (SSA).

You view the items that have reached their reorder point in the Reor-
dering Purchase order window. From this window you can also generate 
the purchase orders needed to replenish your depleted stock.

Set an Item’s Reorder Point
1. Open the Warehouse menu, Open the Inventory submenu, 

and then click Item Manager.

The Item Manager window opens.

2. On the Tools menu, click Item Reorder.

The Item Reorder Point Configurator dialog box opens.

3. In the Item list, select the item for which you want to set its 
reorder point.

4. In the Location list, select your item’s location.

5. In the Reorder Point box, type your item’s reorder point.

6. In the Order Quantity box, type the quantity of the item you 
want to reorder.

SIMMS will not order more of an item than its order quantity. 

7. In the Minimum Order Quantity box, type the minimum 
order quantity you want entered for a purchase order.

SIMMS will not order less of an item than its minimum order 
quantity.

8. In the Maximum Onhand box, type the maximum quantity 
you want on hand for your item.

The quantity of an item SIMMS places on a purchase order plus 
your available stock never exceed your maximum on hand 
quantity.

9. Click Save.

Global Setting and Item Reorder Points
You can adjust how SIMMS calculates your reorder points by selecting 
any of the following Global Settings:
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• Ignore on PO quantities when item reordering
Select this option to ensure SIMMS does not reorder quantities 
already on a purchase order. 

• Include WIP quantity in item reorder point calculation
Click to have SIMMS subtract your WIP quantities from your 
available stock.

• Include backorderd quantity in item reorder point cal-
culation
Click to have SIMMS add backorder quantities to your reorder 
quantity. This ensures that you reorder enough of an item to fill 
any backorders of the item.

Create a Purchase Order to Replenish Your Stock
1. Open the Purchase Order Manager, click the Reordering 

icon .

The Reordering Purchase Order window opens.

2. Click Show.

SIMMS lists in the window your stock items that have reached 
their reorder point.

3. (Optional) In the Qty column, change SIMMS’ suggested reor-
der quantity for the items you are purchasing. 

4. In the Document Number text box, type a document number.

5. Do one of the following:

• If the items you are purchasing come from the same ven-
dor, in the Vendor list, select the vendor you want to pur-
chase your items from, and then click Create POs.

• If the items your are purchasing come from different ven-
dors, click Create POs to Default Vendors.

The items you are purchasing must have a default vendor 
set for them in the Item Manager.

6. SIMMS prompts you to save your purchase order(s). Click Yes.

Creating a Receipt of Goods
Use SIMMS’ Receipts Manager and Receipt window to create your 
receipts.

Begin in the Receipts Manager by creating a blank receipt. This blank 
receipt opens in the Receipt window. There you enter your receipt’s 
details, such as the vendor’s name and the items you are receiving into 
stock.
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Keep in mind that many of the details for a receipt are optional, such as 
a department, shipping account number, vendor alias and so on.

In addition, SIMMS enters many of your receipt’s details automatically, 
depending on what default information you have previously entered 
into SIMMS. For example, if when setting up your vendor’s profile in 
the Vendor Manager, you entered your vendor’s purchase terms, 
SIMMS enters this detail automatically when you create your receipt 
for that vendor.

If your receipt is based on a purchase order you can quickly create a 
receipt by importing your purchase order’s details into your receipt.

Create a Blank Receipt of Goods 
1. Open the Purchasing menu, and then click Receipts Man-

ager.

The Receipts Manager window opens.

2. Click the New icon .

Your blank receipt opens in the Receipt window.

Enter the Header Details for a Receipt of Goods
In the blank receipt you created, enter your receipt’s details. Start by 
entering the appropriate details in the Header tab.

Figure 8: Entering the heading details for a receipt of goods

1. In the Vendor list, select a vendor.

2. In the Contact list, select your contact at the vendor.

3. In the Agent list, select the purchasing agent responsible for 
this receipt.

4. In the Required Date box, select the date you should have 
received the items on your receipt.
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The required date at the receipt stage is used as a reference to 
indicate when you should have received the items on the 
receipt.

By default, SIMMS enters a date 30 days from the current date. 
To change this setting go to Setup > Global Settings > Purchase 
tab > Default Required Date for Purchase Orders.

If you import a purchase order into your receipt, the required 
date from the purchase order is also used as the required date 
for your receipt.

5. In the Document # text box, type a document number.

If you import a purchase order into your receipt, the document 
number from the purchase order is also used as the document 
number for your receipt.

6. In the PO No. text box, type the purchase order number your 
receipt is based on. 

7. If you are using a foreign currency for this receipt, in the For-
eign Currency list, select the currency.

8. In the Department list, select a department.

9. In the Comment text box, type a comment.

This comment appears on your printed receipt.

10. (Optional) In the AP Acct list, select the account payable for 
this receipt.

The AP Acct list is only available if you are using SIMMS’ gen-
eral ledger.

Enter the Shipping Details for a Receipt of Goods
1. Click the Shipping tab.

Figure 9: Entering the shipping details for a receipt of goods
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2. In the Shipping Method list, select the shipping method used 
to deliver your items.

3. In the Ship Account Number text box, type a shipping 
account number.

4. To change the bill-to address for this receipt, in the Bill-To 
Address list, select the new address.

5. To change the ship-to address for this receipt, in the Ship-To 
Address list, select the new address.

6. If the items on the receipt has been delivered directly to your 
customer (drop shipped), click the Customer Drop Ship check 
box. In the list of customers (below the Customer Drop Ship 
check box) select the customer the items on the receipt were 
delivered to.

Attach a Document to a Receipt of Goods
You can attach a document, such as a Microsoft Word file, PDF, or 
image to your receipt.

You can also view the documents you attach to a receipt in the Vendor 
Manager’s entry for your vendor.

To attach a document to a receipt do the following steps:

1. In the Receipt window, click the Attach tab, and then click 
New Document.

The Attach Documents window opens.

Figure 10: Attaching a document to a receipt of goods.

2. Click Browse.

The Find File window opens.

Click Attach to move your 
selected file to the text box.

Click Upload to upload your docu-
ment to your company database.
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3. In the Find File window, locate the document you want to 
attach to your receipt, and then click Open.

The Find File window closes.

4. In the Attach Documents window, click Attach, and then 
click Upload.

SIMMS attaches your document to your receipt.

Add an Item to a Receipt of Goods
You have entered the header and shipping details for your receipt. 
(Optionally, you may have attached a document to your receipt). Next 
you add to your receipt the items you are receiving into stock.

1. Click in the Item Code field, and then click the Search icon 
 that appears.

Figure 11: Adding an item to a receipt.

The Enhanced Search window opens.

2. In the Description field, type the description for your item, 
and then click Find.

Your item is listed in the Enhanced Search window’s grid.

3. Select your item in the window’s grid, and then click Retrieve 
One.

Your item’s details are entered in the Receipt window’s grid.

Tip: There are many ways to enter an item’s details into a receipt of 
goods. For example, you can scan the item’s UPC code or select the item 
from the Stock Window.

In addition, you can type an item’s code or description in the appropriate 
fields of the Receipt window’s grid and then press the Tab key. SIMMS 
automatically enters the remaining details for your item in the row.

If you click in the Item Code field, the Search icon appears. Click the Search 
icon to open the Enhanced Search window. In the Enhanced Search window 
you find and retrieve the item you want to add to your purchase order. 
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Even if you only type a portion of your item’s description or code and 
then press the Tab key, SIMMS is often able to determine the item you 
want. If SIMMS is unable to determine the exact item you want, the 
Enhanced Search window opens, listing the most likely candidates.

Edit an Item’s Details for a Receipt of Goods 
You can edit an item’s details such as its location or quantity. For a list 
and explanation of the item details you can edit, see Table 2: Edit an 
Item’s Details for a Receipt of Goods.

Table 2: Edit an Item’s Details for a Receipt of Goods

Fields Explanation

UM In this field SIMMS enters your 
item’s purchase unit of measure. If 
you have not defined a specific pur-
chase unit of measure for your item, 
SIMMS enters your item’s standard 
unit of measure as its purchase unit 
of measure.

In the field’s list, you can choose any 
of the available units of measure you 
have previously defined for your 
item.

Location In this field SIMMS enters the 
default location of your item. It is 
into this location that your item is 
received and stored. 

You can change this location by 
selecting a new location from the 
fields list.

Manufacturer Lot In this field you type a manufac-
turer’s lot for your item.

Exp. Date In this field you select your item’s 
expiration date from the field’s cal-
endar.
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Alias In this field’s list, you select the alias 
(name) your vendor uses for this 
item.

Comment In this field you type a comment to 
associate with your item.

If your item has an extended descrip-
tion, SIMMS automatically enters it 
in this field. You can edit the 
extended description or replace it 
with a comment.

The item’s extended description/com-
ment appears on your printed pur-
chase order. 

Quantity In this field you type the quantity of 
the item you are ordering.

By default SIMMS enters one (1) as 
your item’s order quantity.

Service In this field’s list, you select the ser-
vice order you want to associate with 
your purchase order.

To appear in this list, the service 
order must be created first.

Markup% In this field you add a markup per-
centage for your item.

After changing the markup percent-
age for your item, its cost (in the 
Cost field) changes to reflect the 
adjustment to the markup percent. 

Table 2: Edit an Item’s Details for a Receipt of Goods

Fields Explanation
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Enter a Freight Charge or Extra Discount in the Totals Pane
The Totals pane appears at the bottom of the purchase order window. It 
contains information such as taxes charged and the grand total. In this 
pane you can add a freight charge and an extra discount to your pur-
chase order.

Figure 12: Entering freight costs and an extra discount in the Totals pane.

1. In the Totals pane, in the Freight box, type the freight charge 
you want to add to your receipt.

2. In the Extra Discount % box, type the percentage of your 
extra discount.

The extra discount is taken off the net total of your receipt.

3. Click the Save icon .

Import a Purchase Order into a Receipt of Goods
You can import a purchase order into your receipt. All the details from 
the imported purchase order are entered into the receipt.

Cost In this field SIMMS enters the cost 
for your item.

You can change your item’s cost. 
After changing your item’s cost, its 
markup percentage (in the Markup% 
field) changes to reflect the adjust-
ment to the item’s cost.

Table 2: Edit an Item’s Details for a Receipt of Goods

Fields Explanation

You can enter freight costs 
to your purchase order.

You can enter an extra discount to 
your purchase order.
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1. Open the Receipts Manager, and then click the New icon .

Your blank receipt opens in the Receipt window.

2. Click the Tools menu, and then click Import from Purchase 
Order.

The Find Transaction window opens.

3. Select the purchase order that you want to import into your 
receipt, and then click OK.

SIMMS enters the details of your purchase order into your 
blank receipt.

4. If required, edit your receipt, and then click the Save icon .

Create a Receipt of Goods Using the Quick Receipt Window
You can create a receipt using the Quick Receipt window. This window 
contains fewer options then SIMMS’ Receipt window.

1. Open the Purchasing menu, and then click Quick Receipt.

The Quick Receipt window opens.

Figure 13: Creating a quick receipt.

2. In the Vendor list, select a vendor.

3. In the Document Number text box, type a document number.

4. In the Location list, select the location into which you are 
receiving your items.

5. In the Item list, select an item.

6. In the Quantity box, type the quantity of the item you are 
receiving, and then click Add.

SIMMS enters the item into the window’s grid.

7. After entering all your items on to the receipt, click Save.
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SIMMS creates your receipt.

Your newly created receipt is listed in the Receipt Manager. 
From there you can open your receipt to view or edit it.

Scan a Receipt of Goods
You are able to scan items into a receipt. To use this feature your 
receipt must be based on a purchase order.

1. Open the Purchasing menu, and then click Scan Receipt of 
Goods.

The Scan Receipt of Goods and the Find Transactions window 
opens.

2. In the Find Transactions window, select the purchase order 
you want to base your receipt on, and then click OK.

3. In the Scan Receipt of Goods window, click inside the UPC 
text box, and then scan your item’s UPC code.

Figure 14: Scanning items to create a receipt of goods.

4. In the Quantity box, type the item’s quantity, and then click 
Insert.

SIMMS enters your item’s details in the window’s grid.

5. Receive all the items for your purchase order, and then click 
Submit.

SIMMS creates your receipt.

Your newly created receipt is listed in the Receipt Manager. 
From there you can open your receipt to view or edit it.
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Entering Serial Numbers into SIMMS
If your items are serialized, you should enter your item’s serial numbers 
into SIMMS when you receive the items into inventory. You can enter 
your item’s serial numbers manually or have SIMMS auto-generate the 
serial numbers.

Manually Enter an Item’s Serial Number into SIMMS
1. If not yet opened, open your receipt in the Receipt window, 

and then click the Serial Number icon .

The Serial Number Manager opens.

In the Document Items pane, SIMMS list the items on your 
receipt that require serial numbers. By default, SIMMS selects 
the first item listed in the Document Items pane. In the Serial 
Numbers pane, SIMMS list the same item as many times as the 
quantity you are receiving into stock.

For example, you have the serialized item, 25” Dell Monitor, on 
your receipt and you are receiving 10 of them into stock. Your 
item, the 25” Dell Monitor, appears in the Document Items 
pane. In the Serial Numbers pane SIMMS lists your item, 25” 
Dell Monitor 10 times. For each time the 25’ Dell Monitor is 
listed you enter a serial number.

Figure 15: Manually enter an item’s serial number into SIMMS.

2. In the Serial Numbers pane, in the SN column, type the serial 
number for your item.

In this column, SIMMS enters 
the number of serial numbers 
required for your item. 

In this column, SIMMS enters 
the number of serial numbers 
you have entered for your item. 

Select an item in the Document 
pane. SIMMS lists the item as many 
times as the quantity your are 
receiving into stock. 
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After you have typed the serial numbers for all your items, in 
the Document Items pane, the number in the SN Items column 
will match the number in the No. of Items column.

3. Click the Save Serial Numbers link.

Auto-Generate Serial Numbers
1. If not yet opened, open your receipt in the Receipt Window, 

click the Serial Number icon .

2. In the Document Items pane, select an item.

3. In the Serial Number pane, place your curser in the first field 
of the SN column.

4. In the auto-generate section (bottom right) do the following 
steps.

Figure 16: Auto-generating serial numbers.

a. (Optional) In the Pre-sequence string text box, type the 
characters you want to appear at the beginning of your 
serial number.

For example, if you type CB as your pre-sequence string, 
CB appears at the beginning of all your serial numbers.

b. (Optional) In the Post-sequence string text box, type the 
characters you want to appear at the end of all your serial 
numbers.

For example, if you type T3V as your post-sequence string, 
T3V appears at the end of your serial number.

c. In the Current value box, type the number you want 
SIMMS to use as the first sequential number.

d. In the Incremental box, type the number you want to 
increment the current value by.

This configuration generates 
40 serial numbers. The first is 
CB0T3V and the next few in 
the series CB1T3V, CB2T3V, 
CB4T3V.
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For example, if your current value is 0, and your incremen-
tal value is 1 the first sequential number is 0, the next few 
numbers are 1, 2, 3, and so on.

e. In the Iteration box, type the number of serial numbers 
you want SIMMS to generate.

5. Click Generate.

For the selected item, notice in the Document Items section the 
total number of items in the No. of Items column now matches 
the number in the SN Items column.

6. Click the Save Serial Numbers link. SIMMS prompts you to 
confirm you want to save your serial numbers. Click Yes.

7. Close the Serial Number Manager.

8. In the Receipt window, if your receipt is in edit mode, click the 

Save icon .

Working with Receipt of Goods
The Receipts Manager is designed as the entry point from which you 
perform many of the tasks related to working with your receipts. For 
example, from the Receipts Manager you can, confirm a receipt, void a 
receipt, and view an existing receipt.

Figure 17: The Receipts Manager.

From the toolbars you have access to 
most of the features needed to work 
with your receipt.

SIMMS lists in the Receipts Manager your 
receipts. The list is filtered by date.
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View an Existing Receipt of Goods

 Open the Receipts Manager, and select the receipt you want 

to view, and then click the View icon .

Your selected receipt opens in the Receipt window.

Print a Receipt of Goods
1. Open the Receipts Manager, select the receipt you want to 

print, and then click the Print icon .

Your receipt opens in the Report window.

2. Click the Print icon .

Edit a Receipt of Goods
1. Open the Receipts Manager, select the receipt you want to 

edit, and then click the View icon .

Your selected receipt opens in the Receipt window.

2. Click the Edit icon .

3. Edit your receipt, and then click the Save icon . 

Delete a Receipt of Goods
Deleting a receipt permanently removes the receipt from SIMMS. All 
the items on the receipt are removed from stock. You cannot delete an 
receipt if there is a payment made on it. In this case, you need to void 
the receipt or return the items on the receipt.

Caution: To avoid loss of critical data and an audit trail, it is recom-
mended that you do not delete a receipt. Instead, void your receipt or 
return the items on the receipt.

To delete a receipt do the following steps:

1. Open the Receipts Manager, select the receipt you want to 
delete, and then on the File menu click Delete.

2. SIMMS prompts you to confirm that you want to delete the 
receipt, click Yes.

3. SIMMS confirms the receipt is deleted. Click OK.

Void a Receipt of Goods
Unlike a deleted receipt, a receipt that is voided remains in SIMMS. 
The receipt is given the status of void. In addition, SIMMS creates a 
credit memo applying the credit to the appropriate expense account. 
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1. Open the Receipts Manager, select the receipt you want to 
void, and then on the File menu click Void.

2. SIMMS prompts you to confirm that you want to void this 
receipt, click Yes.

The Date Selection dialog box opens.

3. By default the current date is set as the date for the credit 
memo. Change the date if required, and then click Save.

4. SIMMS displays a question asking if you want to create a new 
receipt based on the receipt you are voiding. Click either Yes or 
No.

If you click Yes, SIMMS creates an exact copy of your receipt. 
You can open your receipt to view it from the Receipt Manager.

5. SIMMS displays a question, asking if you want to add an extra 
charge to the credit memo. Do one of the following steps:

• Click Yes. A dialog box opens. In the Select Misc. 
Charge Item list, select the charge you want add to the 
credit memo, and then in the Quantity list, type its quan-
tity. Click Save. SIMMS displays a question asking you to 
confirm that you want to save the charge, click Yes.

• Click No.

6. SIMMS confirms your receipt is voided. Click OK.

You can view your voided receipt and credit memo from the 
Receipts Manager.

Return the Items on a Receipt of Goods
You can return some or all of the items on a receipt. SIMMS creates a 
credit memo for the value of the items returned to your vendor. If you 
are using SIMMS’ general ledger, the credit memo is applied to the 
appropriate expense account.

1. Open the Receipts Manager, select the receipt which has the 
items your are returning to your vendor, and then click the 

View icon .

Your selected receipt opens in the Receipt window.

2. Click the Return Document icon .

3. SIMMS prompts you to confirm that you want to return the 
items on the invoice, click Yes.

SIMMS creates a credit memo. This document looks the same 
as your original invoice, but the charges have a negative value 
and the text box Original Order No is added to the Header tab. 
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SIMMS enters in the Original Order No text box the Receipt No 
for the receipt your credit memo is based on. 

Figure 18: Credit memo totals for a returned item have a negative value.

4. If you are returning only some of the items on your receipt, 
delete those items you are not returning, leaving only the items 
you want to return.

5. Click the Save icon .

6. SIMMS displays a question, asking if you want to add an extra 
charge to the credit memo. Do one of the following steps:

• Click Yes. A dialog box opens. In the Select Misc. 
Charge Item list, select the charge you are adding to the 
credit memo, and then in the Quantity list, select its 
quantity. Click Save. SIMMS displays a question asking 
you to confirm that you want to save the charge, click Yes.

• Click No.

7. SIMMS confirms your receipt is voided. Click OK.

SIMMS creates a credit memo for the items returned and cred-
its the appropriate expense account.

SIMMS changes the status of your invoice to either fully 
returned or partially returned, depending on whether all or 
some of the items on the invoice have been returned.

You can open to view your receipt or credit memo from the 
Receipt Manager.

Reports
SIMMS has many reports related to the purchasing process. These 
reports are available throughout SIMMS. For example, you can view 
the Unreceived Purchase Orders report from the Reordering Purchase 
Order window.
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You can also view the Unreceived Purchase Orders report and all 
reports related to the purchasing process from the Reports Center.

View Purchasing Reports from the Reports Center
1. Open the Reporting menu, open the Reports Center sub-

menu, and then click Reports Center.

The Reports Center window opens.

2. On the View Reports tab, click Purchases.

A tree menu listing the purchasing reports appears.

3. Click the name of the report you want to view, and then click 
Display.

Depending on the report you select a dialog box may appear. 
This dialog box enables you to filter and group the information 
on the report.

Descriptions of Some Purchasing Reports
Table 3: A Sample of Available Purchasing Reports lists some of the 
reports available in the Report Center and a description of the reports.

Restrict Access to a Purchasing Report
Reports may contain confidential information. You can restrict access to 
any report in SIMMS.

Table 3: Sample of Available Purchasing Reports

Report Description

Landed Costs Report Use this report to view the landed 
costs for items received into stock.

You can filter this report by date, 
vendor, or item.

Unreceived Item Report Use this report to view which items 
on a purchase order have not been 
received into stock.

Inventory Receiving 
History Report

Use this report to view the quanti-
ties of an item received into stock 
over the last 30, 90, and 180 days.
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1. Open the Administration menu, and then click User Man-
ager.

2. In the list of users (left most), click the user for whom you want 
to restrict access to a report, and then click the Edit icon .

3. Click the User Rights tab.

4. In the tree menu, expand Reports, and then expand Purchas-
ing.

5. In the Access Rights column, clear the check box for the 
report you do not want the user to see.

6. Click the Save icon .

Purchase Order Approval
In SIMMS, you can implement a single tier approval process. This 
means that a purchase order is reviewed by one person before it is 
released to a vendor.

A purchase order that is not approved has “Not Approved” appear at the 
top of the purchase order. In addition, you are unable to import that 
purchase order into a receipt of goods.

To enable purchase order approval you need to select the appropriate 
option in Global Settings.

Enable Purchase Order Approval
1. Open the Setup menu, and then click Global Settings.

The Global Settings window opens.

2. Click the Purchase tab, and then click the Import Approved 
PO Only check box.

3. Click Save.

Approve a Purchase Order
Only users with the role of purchasing agent assigned to them in the 
User Manager can approve a purchase order.

To approve a purchase order do the following steps:

1. Open the Purchasing menu, and then click the Purchase 
Order Manager.

2. Click the PO Awaiting Approval icon .

The Approve Purchase Order window opens.

3. In the Approved column, click the check box for the purchase 
order you want to approve, and then click Save.
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4. To view a purchase order, select the purchase order, and then 
click Detail.

Purchase Order Authorization
In SIMMS, you can implement a two tier purchase order authorization 
process. This means that a purchase order is reviewed by up to two dif-
ferent people before it is released to a vendor.

To use purchase order authorization you must do the following tasks:

• Enable purchase order authorization in Global Settings.

• Assign the appropriate role to a user in the User Manager.

In addition to enabling purchase order authorization, you can have 
SIMMS send alerts and e-mails to submitters, approvers, and authoriz-
ers, notifying them of a purchase order’s progress through the authori-
zation process.

For example, with the appropriate alerts selected in Global Settings, if 
an authorizer declines authorization of a purchase order, the approver 
receives an alert indicating that a purchase order has been declined 
authorization.

Alerts and e-mails are a helpful way for those involved in the purchase 
order authorization process to communicate with each other. 

Enable Purchase Order Authorization
1. Open the Setup menu, and then click Global Settings.

The Global Settings dialog box opens.

2. Click the Purchase tab. Click the Import Approved PO 
Only check box, and then click Use Budgets - Purchase 
Order Authorization check box.

3. Click Save.

Enable Authorization Alerts and E-mails
1. In Global Settings, on the Purchase tab, under Use Bud-

gets - Purchase order Authorization, click any of the alerts 
and e-mails you want to send to those users involved in the 
authorization process.
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See Table 4: Authorization Alerts and E-mails, for an explana-
tion of the alerts and e-mails that you can send to submitters, 
approvers, and authorizers.

Table 4: Authorization Alerts and E-mails

Check Box Action

PO Submitted - All 
Approvers Alerted

Click to send alerts to approvers when 
a purchase order is submitted.

Send E-mail Click to also send an e-mail to approv-
ers when a purchase order is submit-
ted.

Approver Declines 
an Order - Submit-
ter Review

Click to send alerts to submitters when 
a purchase order is declined approval. 

The submitter reviews the approver’s 
comments, adjusts the purchase order, 
and then approves the purchase order 
again.

Send E-mail Click to also send an e-mail to a sub-
mitter when a purchase order is 
declined approval.

Order Approved - 
Send Alert

Click to send alerts to submitters and 
authorizers when a purchase order is 
approved. 

Send E-mail Click to also send an e-mail to submit-
ters and authorizers when a purchase 
order is approved.

Authorizer 
Declines an Order 
Approval Review

Click to send alerts to approvers when 
an authorizer declines authorization of 
a purchase order.

The approver reviews the authorizer’s 
comments, adjusts the purchase order, 
and approves the revised purchase 
order.
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Assign Roles for the Purchase Order Authorization Process
After you have enabled purchase order authorization, in the User Man-
ager, assign the appropriate roles to those users involved in the authori-
zation process. There are three roles in the purchase order 
authorization process:

• Submitter
A submitter creates a purchase order, but cannot approve or 
authorize the purchase order.

Send E-mail Click to also send an e-mail to the 
approvers when an authorizer declines 
authorization of a purchase order.

Order Authorized 
- Send Alert

Click to send an alert to approvers and 
submitter when a purchaser order is 
authorized.

Send E-mail Click to also send an e-mail to approv-
ers and submitters when a purchase 
order is authorized.

Order Shipped - 
Send Alert

Click to send an alert to authorizers, 
approvers, and submitters when a pur-
chaser order is shipped.

Send E-mail Click to also send an e-mail to autho-
rizers, approvers, and submitters, 
when an purchase order is shipped.

Order Received - 
Send Alert

Click to send an alert to authorizers, 
approvers, and submitters when the 
items on the purchase order are 
received into stock.

Send E-mail Click to also send an e-mail to autho-
rizers, approvers, and submitters when 
the items on the purchase order is 
received into stock.

Table 4: Authorization Alerts and E-mails

Check Box Action
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• Approver
An approver approves a purchase order from the submitter, but 
cannot authorize it. An approver can also create a purchase 
order.

• Authorizer
An authorizer authorizes a purchase order from an approver. 
After a purchase order is authorized, the purchase order is 
released to the vendor. An authorizer can also create a pur-
chase order.

To assign a purchase order authorization role to a user, do the following 
steps:

1. Open the Administration menu, and then click User Man-
ager.

The User Manager window opens.

2. In the list of users (left most), select the user to which you want 
to assign a role in the authorization process, and then click the 

Edit icon .

3. Click the PO Authorization tab, and then click the role that 
you want to assign to the user (submitter, approver, autho-
rizer).

Figure 19: Selecting user roles for purchase order authorization.

4. Click the Save icon .

Authorize a Purchase Order
What you can do as part of the purchase order authorization process 
depends on your assigned role (submitter, approver, authorizer). Each 
role has a set of unique tasks associated with it. However, the steps 
involved in performing any of these tasks are the same.

1. Open the Purchasing menu, and then click Purchase Order 
Manager.
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The Purchase Order Manager window opens.

2. Click the PO Authorization icon .

The Find Transaction window opens.

3. In the Find Transaction window, select the purchase order 
you want to process.

4. In the Action list, select the appropriate action for your given 
role. See Table 5: Actions for the Authorization Process.

Table 5: Actions for the Authorization Process

Role Action

Submitter Submit
Select this option to resubmit a purchase 
order that was declined approval.

Ship
Select this option to change the status of a 
purchase order to Shipped. The status 
Shipped indicates the purchase order has 
been sent to the vendor.

Receive
Select this option to change the status of a 
purchase order to Received. The status 
Received indicates that the items on the 
purchase order have been received into 
stock. 

Approver Decline Approval
Select this option to decline approval for a 
purchase order.

Approve
Select this option to approve a purchase 
order.

Authorizor Decline Authorization
Select this option to decline authorization 
for a purchase order.

Authorize
Select this options to authorize a purchase 
order.
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Purchase Order Budgets
A purchase order budget is an optional feature you can add to the pur-
chase order authorization process. It is only available for SIMMS two 
tier purchase order authorization process.

Use purchase order budgets to limit and track how much money is 
spent for a particular purpose (such as, office supplies). A purchase 
order budget is made up of at least one budget account. Each budget 
account has a sum of money allocated to it.

You assign a budget category and the appropriate account to the pur-
chase orders that you create. When the items on the purchase order are 
received into inventory the dollar value of the purchase order is 
removed from the available money in the budget account.

You cannot authorize a purchase order if there is no money left in the 
budget account assigned to that purchase order.

To add purchase order budgets to the authorization process you need to 
do the following tasks:

• Enable budget limits.

• Create a budget category.

• Assign a user (yourself) to a budget category.

• Create a budget account.

Enable Budget Limits on Purchase Orders and Receipts
When you enable budget limits, you are required to select a budget cat-
egory and budget account for each purchase order or receipt of goods 
you create.

To enable budget limits do the following steps:

1. Open the Setup menu, and then click Global Settings.

The Global Settings dialog box opens.

2. Click the Purchase tab, and then click the Enforce Budget 
Limits in PO and Receipts check box.

3. Click Save.

Create a Budget Category
1. Open the Purchasing menu, and then click PO Budget 

Setup.

The Budget Categories-Accounts dialog box opens.

2. Click Categories.

The Budget Category dialog box opens.
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3. Under Enter Data, type the name of your category, and then 
click Save.

4. Close the Budget Category dialog box.

Next, you need to assign yourself to the budget category you created. 
Only users that are assigned to a budget category can create budget 
accounts for that budget category.

Assign a User to a Budget Category
A user that is assigned a budget category is able to view, create, and 
adjust budget accounts. In addition, a user can spend the money allo-
cated to a budget account. If a user is not assigned to a budget category, 
the budget category and its accounts are not available to the user when 
they create a purchase order or receipt of goods. This ensures only users 
which are assigned to a specific budget category and its accounts can 
spend the money from that account.

To assign a user to a budget category do the following steps:

1. Open the Administration menu, and then click User Man-
ager.

The User Manager window opens.

2. Select a user from the list (left most), and then click the Edit 
icon .

3. Click the PO Authorization tab, and then under Budget 
Categories, click the check box for the budget you want to 
assign to the user.

4. Click the Save icon .

Create a Budget Account
You must be assigned to a budget category in the User Manager before 
you can create a budget account for that category. Your budget account 
is where you allocate the money for a specific purpose. Each budget cat-
egory must have at least one budget account assigned to it. However, 
each budget category can have multiple accounts.

For example, a budget category such as Maintenance may have the 
accounts Yard, Building, and Cleaning. Each account has its own 
money allocated to it. Multiple accounts for a budget category enables 
you to closely control and monitor what money is spent for any given 
purpose.

To create a budget account do the following steps:

1. Open the Purchasing menu, and then click PO Budget 
Setup.
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The Budget Categories-Accounts dialog box opens.

2. Click Accounts.

The Budget Detail window opens.

Figure 20: Creating a budget account.

3. In the Budget Account text box, type the name of your 
account.

4. In the Budget Category list, select the budget category you 
want to assign this account to.

5. In the Budget Year box, SIMMS enter the current year. You 
can change the year if you want.

6. In the Value box, type the account value (this is how much 
money is available in the account).

7. In the Comment text box, type a comment that you want to 
include with your account details, and then click Save.

Your comment appears in the Budget Report.

Print a Budget Report
The Budget Report displays the activity (such as the money spent, 
reserved and available) for your budget categories and their accounts. 

1. On the Purchasing menu, click PO Budget Setup.

The Budget Categories - Accounts dialog box opens.

2. Click Print.

The Budget Report dialog box opens.

The budget account 
Office has a value of 
$2,000.00 dollars. After 
saving your budget 
details, SIMMS enters the 
Value amount into the 
Limit box. You cannot 
change a budget 
account’s limit. But, you 
can add money to a bud-
get account. Any money 
you add to a budget 
account appears in the 
Adjust box.
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3. In the dialog box you can filter your report by date. Clear any of 
the check boxes for the budget categories and accounts you do 
not want to include in the Budget Report. click Print.

The Budget Reports opens in the Report window.

4. Click the Print icon .

View an Existing Budget Account
1. Open the Purchasing menu, and then click PO Budget 

Setup.

The Budget Categories-Accounts dialog box opens.

2. In the Budget Category list, select the budget category your 
account is assigned to.

3. In the Budget Account list, select the budget account you 
want to view, and then click Accounts.

The Budget Details dialog box opens showing your budget 
account’s details.

Add Additional Money to a Budget Account
You cannot change the original amount of money allocated to a budget 
account, but you can add more money to the budget account.

1. Open the Purchasing menu, and then click PO Budget 
Setup.

The Budget Categories-Accounts dialog box opens.

2. In the Budget Category list, select the budget category your 
account is assigned to.

3. In the Budget Account list, select the budget account you 
want to add, and then click Accounts.

The Budget Details dialog box opens showing your budget 
account’s details.

4. Click the Adjust link.
40 March 18, 2011 SIMMS 8.0 · Purchasing



The Adjust budget section appears in the dialog box.

Figure 21: Adjusting a budget account.

5. In the Value box, type the amount of money you want to add to 
your account, and then click Save.

The amount you enter in the Value box is entered in the Adjust 
box.

6. In the Comment text box, type a comment that you want to 
include with your adjustment.

Your comment appears in the Budget Report. It can be up to 
40 characters long.

Purchase Order Authorization Limits
You can limit the maximum (and minimum) dollar value a user can 
authorize for a purchase order. 

For example, in Global Settings you have selected the option Import 
Approved PO Only. This enables any purchaser to approve a purchase 
order. If, for this example, you have two purchasers, you can assign to 
each one an authorization limit. For one purchaser you can assign the 
authorization limit of $0 - $500. This means that purchaser can only 
authorize purchase orders with a value of $500 dollars or less. For the 
second purchaser you can assign the authorization limit of $501 - $1000 
(or $0 - $1000 its up to you). This means that the second purchaser can 
only authorize purchase orders between the value of $501 - $1000 (or 
the value $0 - $1000 if you choose).

You can use purchase order authorization limits with both SIMMS one 
and two tier. 
SIMMS 8.0 · Purchasing May 18, 2011 41



Create a Purchase Order Authorization Limit
1. Open the Administration tab, and then click User Manager.

The User Manager window opens.

2. Click the PO Authorization tab, under Min/Max PO Autho-
rization Limits click the goggles icon.

The PO Authorization Group Setup dialog box opens.

Figure 22: Setting up purchase order authorization groups.

3. In the Enter data text box, type the name of your purchase 
order authorization limit.

4. In the Minimum PO Value box, type a minimum dollar value.

5. In the Maximum PO Value box, type a maximum dollar 
value.

6. Click Save. 

Assign a Purchase Order Authorization Limit to a User 
1. Open the Administration menu, and then click User Man-

ager.

The User Manager window opens.

2. In the list of users (left most), select the user you want to assign 
a purchase order authorization limit to, and then click the Edit 

icon .

3. Click the PO Authorization tab, and then in the PO Autho-
rization Group list, select the authorization limit you want to 
assign to the user.
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4. Click the Save icon . 

Matching Invoices to Receipts of Goods
You have the option to manually match your vendor’s invoice to your 
receipt. You do this to ensure the details (such as the total and quan-
tity) are the same for both documents. After you confirm the details of 
your documents match, SIMMS generates an accounts payable invoice. 
You can then view and pay that invoice in the AP Manager.

In Global Settings, the following options determine when you need to 
match an invoice to a receipt:

• Auto AP invoice
Use this option to have SIMMS automatically generate an 
accounts payable invoice for your receipt of goods. With this 
option, you do not manually match your vendor’s invoice to 
your receipts.

• Prompt for auto AP invoice
Use this option to choose each time you save a receipt whether 
to have SIMMS automatically generate an accounts payable 
invoice, or for you to manually match your vendor's invoice to 
your receipt before SIMMS generate an accounts payable 
invoice.

• No auto AP invoice
Use this option if you want to always match your vendor’s 
invoice with your receipt of goods before SIMMS generates an 
accounts payable invoice. 

Match a Vendor’s Invoice to Your Receipt of Goods
1. Open the Purchasing menu, click Receipts Manager.

The Receipts Manager window opens.

2. Click the Receive Invoice icon .

The Unmatched Receipts window opens.

SIMMS automatically lists in the window the receipts that are 
not matched to an invoice.

3. Select the receipt that you want to compare to your vendor’s 
invoice, and then click Details.

Your receipt opens in the Receipt of Goods window.

4. Compare the details of your vendor’s invoice with those of your 
receipt to confirm they match, and then close the Receipt of 
Goods window.
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5. Return to the Unmatched Receipts window, in the 
Unmatched column, click the check box for the receipt that 
you are confirming matches with your vendor’s invoice and 
then click Proceed.

6. SIMMS displays a question, asking if you want to edit the your 
receipt or create an invoice. Do one of the following steps:

• Click Edit Receipt. SIMMS opens your receipt in the 
Receipt of Goods window. Edit your receipt, and then click 

the Save icon .

After you edit your receipt, to generate an accounts pay-
able invoice repeat step 5. For step 6, click Invoice.

• Click Invoice. SIMMS generates an accounts payable 
invoice. You can view and pay this invoice in the AP Man-
ager.

Adding Landed Costs to Items on a Receipt of 
Goods
You can add your landed costs to the items on your receipt. There are 
two types of landed costs in SIMMS: static landed costs and additional 
landed costs. 

Static landed costs are added to a single item on your receipt. You can 
pre-define an item’s static landed costs at Setup > Landed Costs 
Setup

Additional landed are distributed over all the items on your receipt. 

You can apply both types of landed cost to the items on a receipt.

Distribute Additional Landed Costs Between Items
1. If not already opened and in edit mode, open your receipt and 

click the Edit icon .

2. On the Tools menu, click Landed Costs.

The Apply Landed Costs window opens.

3. On the Setup tab, click the Add fixed values to a receipt 
check box.

4. Click the Add the additional costs into the item cost check 
box.

If you do not select this check box, SIMMS does not add your 
landed to the items on your receipt. However, SIMMS does gen-
erate a receipt for each vendor due landed costs.
44 March 18, 2011 SIMMS 8.0 · Purchasing



5. Click the Fixed Totals Values tab, in the available boxes 
(Freight, Insurance, Brokerage, Customers, Others) type the 
appropriate landed costs.

6. Choose one of the following options:

• Redistribute amounts per item quantity.
Your landed costs are distributed evenly by quantity.

• Redistribute amounts per item quantity/price.
Your landed costs are distributed based on an item’s price. 
The greater an item’s price the greater its portion of the 
landed cost.

• Redistribute amounts per item quantity/weight.
Your landed costs are distributed based on an item’s 
weight. The greater an item’s weight, the greater its por-
tion of the landed cost.

7. Click Save, and then click the Vendors tab.

8. In the available lists (Freight, Insurance, Brokerage, Customs 
Cost, and Other cost 1) select the vendors owed the appropriate 
landed cost, and then click Save.

Add Static Landed Costs to an Item on a Receipt of Goods
1. If not already open and in edit mode, open a receipt and click 

the Edit icon .

2. On the Tools menu, click Landed Costs.

The Apply Landed Costs window opens.

3. On the Setup tab, click Add landed costs setup values to 
the item FOB cost.

4. Click the Add the additional costs into the item cost check 
box.

If you do not select this check box, SIMMS does not add your 
landed to the items on your receipt. However, SIMMS does gen-
erate a receipt for each vendor due landed costs.

5. Click the Item Setup Values tab, and then do one of the fol-
lowing steps:

• If your item does not have pre-defined landed costs, in the 
appropriate boxes (Duty rate, Excise Tax, Freight, Com-
mission, and so on) type the percentage of your item’s FOB 
cost you want to add as its landed cost, and then click 
Save.
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• If your item has pre-defined landed costs, click Save. If 
required, you can edit your item’s pre-defined landed costs 
before you save them.

6. Click Save Changes, and then click Save.

7. Click the Vendors tab, if required you can change the vendors 
who are owed landed costs.

On the Vendors tab is listed the costs for each type of landed 
cost (Duty rate, Excise Tax, Freight, Commission, and so on). In 
the Total Landed Cost text box, SIMMS enters the total landed 
cost for your item.

8. Click Save. 

See Also
Inventory Replenishment

This document explains how to use SIMMS’ Replenishment Manager. 
Use the Replenishment Manager to maintain economic stock levels and 
at the same time prevent stock shortages.

The Replenishment Manager is designed as a pull-based supply chain 
tool. As such, it is sales orders (demand) that trigger stock replenish-
ment.

Request for Quote (RFQ)

This document explains how to use SIMMS’ RFQ Manager. Use the 
RFQ Manager to create and process your request for quotes.

In addition, this document explains how to setup and use the RFQ Sub-
mission Portal. This is an optional web component that enables you to 
submit your RFQs to a website (the RFQ Submission Portal) and for 
your vendors to respond to your RFQ in the same website.
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